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4.1 OVERVIEW

This Section describes the Windows-based simplified sewerage design program
contained on the CDROM supplied with this Manual. The purpose of the program is
to aid the design of simplified sewerage systems. It seeks to do this by:

(1) automating – and thus speeding up – the necessary design calculations;
(2) providing a tool for analysing different design permutations / configurations; and
(3) being suitable for training / learning purposes.

The program should only be used by engineers who are “computer-literate.”  It is not
really suitable for use by others.

4.1.1 System requirements

The program will run on any of the following Microsoft Windows-based operating
systems:

Windows 95
Windows 98

Windows 2000
Windows NT4

It will not run on computers running the Windows 3.1 operating system.

The monitor screen resolution must be 800 x 600 pixels or greater (this is a very
common resolution – only one step up from the minimum possible).

The hardware requirements are not demanding – any PC capable of running one of
the above versions of Windows should be able to run this program.

4.1.2 Obtaining the program

If the CDROM is missing from this copy of the Manual, there is an Internet website
from where the program can be downloaded; its address (URL) (which is case-
sensitive) is:

http://www.efm.leeds.ac.uk/CIVE/Sewerage
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From this site you can obtain the most up-to-date version of, and latest information
on, the program.

4.1.3 The definition of a sewer network used in the program

The program requires the sewer network to be described as a series of linked sewer
pipes. The sewers may only be linked in a tree type manner – that is, the network
expands from the most downstream point branching at junctions to several upstream
ends. And there must be no loops in the network. (The program has built-in
automatic checks which show warnings if any network is entered that cannot be
calculated.)

To cater for designing individual sections of a sewer network (which may be drawn
together at the end of the design process), the network may be split into sub-
networks, termed sub-nets in the program. Sub-nets may join other sub-nets at
“drop” junctions – i.e. those at which the sewers are not necessarily at the same
level. The typical case would be for a small branch sewer sub-network to be
designed. When complete, this needs to be linked into a main street/collector sewer
that may be at a much lower level.

In summary:

• A network consists of one or more sub-nets which may join at drop junctions.

• A sub-net is a tree structure of sewers whose ends join at continuous levels, i.e.
without drop junctions.

In general sub-nets correspond to condominial systems as detailed in Section 3.3.6,
and these then form the input into public collector sewers as described in Section
3.3.7.

4.1.4 The minimum information necessary to use the program

As a minimum to get your basic layout entered, you will need the length of the sewer
and number of people connected to it (this may be described in terms of the number
of houses connected together with a mean number of people per house, or in terms
of a single total number of people who live in houses connected to the sewer). To be
of practical use you will also need the ground levels at the end of each sewer length.

4.1.5 Getting started

If you really want to jump straight into a design, you can go directly to Section 4.7,
where four step-by-step examples are presented. The next sections describe in
detail the various screens contained within the program.

On first starting the program you are presented with the screen shown in Figure 4.1.



43

Figure 4.1 The Initial screen.

Below the main menu bar are four buttons (Figure 4.2) which allow you to switch
between the four main screens of the program:

Figure 4.2 The main Tool Button bar.

The first button takes you to the Visual Editor screen.  This is the screen that is
shown when you first start the program – see Figure 4.1. Here you can draw the
sewer network on-screen and also edit all the network description parameters. It
provides the normal means of entering all the necessary design data. Section 4.2
contains a detailed description of this screen. An alternative to this method of
entering data is by using the Data Entry/Edit screen – see below. You may use
either or both of these screens to edit your network data.

The second button switches to the Data Entry/Edit screen.  This is the alternative,
table-based method for editing the sewer network description. It is described in detail
in Section 4.3.

The third button takes you to the Results Table screen – a table of the detailed
design results for the sewer network. Here you may also change some of the design
calculations and recalculate to show these changes. Section 4.4 contains a detailed
description of this screen.
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The fourth button displays the Calculator screen. On this screen you can see the
details of calculations performed for each sewer in the network and adjust the
parameters to examine possible design changes. This screen is fully described in
Section 4.5.

Figure 4.3 Exit button.

There is a fifth button on this toolbar – the Exit button (Figure 4.3), to allow you to
leave the program. You will be prompted for confirmation to prevent accidental
closure of the program or closure before first saving your edited network.

4.2 VISUAL EDITOR SCREEN

This screen (Figure 4.4) allows you to draw the sewer network on-screen and also
edit all the network description parameters. This screen should be used as the main
set-up screen for any network that you wish to develop, following the procedure
given in Section 3.3.6. From this screen all network changes can be made.  An
alternative method of changing/specifying the network is provided using the Data
Entry/Edit screen (Section 4.3) where all changes are made by entries in tables and
boxes. Changes made on one screen are automatically changed on the other.

Figure 4.4 Visual Editor screen.
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Note that this screen does not draw the network to scale. Lengths drawn on the
screen do not necessarily represent the actual length on the ground, or the actual
length entered in the data; thus changing the data values in the program will not
change the view on the screen. The reason for this is that simplified sewerage is
designed without requiring a detailed survey of positions of sewer ends (only levels
are required); hence the co-ordinates of sewer ends are not usually known. It would,
of course, make sense to draw any network on the screen to look similar to that
being designed on the ground.

There are three main parts to this screen: the toolbar (Figure 4.5), which allows
setting of the editing and display options for the network.

Figure 4.5 Visual Edit toolbar.

The details panel to the right provide the means for giving, and allowing changes to,
details of either the selected sewer or junction (see Figures 4.12 and 4.15)

The initially blank white panel (Figure 4.1) is where the network will be displayed and
the status bar at the bottom (Figure 4.6) displays such information as scale factor,
and the mouse co-ordinates.

Figure 4.6 Status bar.

On starting the program this screen shows a blank white panel (Figure 4.1). You
have two options at this point:

(1) To read in an existing network, or
(2) To start drawing your sewers on the white panel.

1. To read an existing file:

An existing network can be read from the main menu by choosing the File/Read
Network option (Figure 4.7).

You will be prompted to choose a sewer network file. These files have the extension
“.snt” and all existing network files will be displayed in the open file dialog box.
Several network files are supplied with the program in the directory Networks.

When you have chosen the file and clicked the open button, it will be read in and you
will see a display similar to that of Figure 4.4. You can now edit this network, change
any parameters or perform the calculation.
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Figure 4.7 The file menu showing the “Read Network” option.

2. To draw a new network:

To start drawing you need to be in “Draw mode”. Click on the Draw Mode button (a
picture of a yellow pencil) (Figure 4.8).

Figure 4.8 Draw Mode button.

Press the left mouse while on the white panel, keep it pressed, move the mouse, and
a grey line will be drawn. When you release the mouse button the line will be turn
blue, indicating a sewer, and there will be a maroon square at each end indicating
junctions. The sewer and the junctions will all have default names chosen by the
program. These can easily be changed later. Do the same again with the mouse and
you can draw several more sewers.

Zooming in and out

To zoom in and out of the sewer diagram you need to be in “Zoom mode”. To switch
to zoom mode, press the Zoom Mode button shown in Figure 4.9.

Figure 4.9 Zoom Mode button.

To zoom in, click the left mouse button. To zoom out click the right mouse button.
The position of the click moves to the centre of the panel. Note that text and
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junctions do not change size. The amount of zoom (scaling) is shown in the status
bar at the base of the window (Figure 4.6).

Displaying and changing details of a sewer

Change to “Edit mode” by clicking the button shown in Figure 4.10 and choose
“Sewer” from the two options in the “Item to select” box next to it.

Figure 4.10 Edit Mode button and selector.

Now click (left or right button) on the white panel. The nearest sewer will turn red
(Figure 4.11) and its details will be displayed on the panel to the right (Figure 4.12).

Figure 4.11 A highlighted selected sewer.
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Figure 4.12 Details of selected sewer.

A sewer has the following properties:

1. Name,
2. Length (in metres),
3. Upstream junction name,
4. Downstream junction name,
5. Whether the U/S junction is a datum, and if so its level,
6. Whether the D/S junction is a drop junction,
7. Initial infiltration rate (in litres per day),
8. Final expected infiltration rate (in litres per day), and
9. Description of the initial and final number of people connected to the sewer

(i.e. number of houses linked to the upstream junction).

In the example shown in Figure 4.12, sewer “sewer05” is 20m long, its upstream
junction is named j6 and its downstream junction j5.  From the details we cannot tell
whether the upstream junction is a datum, but from the screen view (Figure 4.11) we
can see that it is not as it is not marked with a yellow box. The sewer has no initial
infiltration and none expected at the end of its life. Initially one house is linked to the
upstream junction, and at the end of its life there will still only be one house
connected. An increase in population can be designed for by changing the average
number of people per house in the initial and final calculations – this is done on the
Results Table screen. An alternative would be to specify the initial and final number
of people in the houses that connect to the sewer.

Any of the above values may be altered in the Edit box – as you type, the text colour
will change to red. It will change to black when you click on another box – if it does
not change back to black, it has not been recorded!
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To change the name of the sewer, simply type a new name. Clicking on the next box
or clicking the “Apply Changes” button will change the text colour to black and record
the change. (Note that the Apply Changes button does not need to be pressed if the
colour has changed – but it does no harm to press it!)

In this example you can see that “sewer05” has a upstream junction named “j6” and
a downstream junction “j5”. To change this connectivity, just select a different
junction from the list for either the upstream (U/S) or downstream (D/S) junction
name.

Datum setting

All sub-nets need one junction to be specified as the datum junction. To do this you
select the sewer whose upstream junction will be the datum. Then on the Sewer
Details panel click on the “Set this junction as datum” button. This will display the
dialog box shown in Figure 4.13.

Figure 4.13 Datum setting dialog.

Click the check box to set the junction shown as the datum. You can specify the
actual datum invert level by clicking the “Set datum value” check box and entering a
value. Alternatively, and more conveniently, uncheck this check box (as shown in
Figure 4.13) which will tell the program to calculate a datum level based on the
ground level of the junction and the minimum cover. You will need to press the
“Apply” button to save this information and close the dialog box.

When attempting to do the calculation, you will be given a warning if there is no
datum set or if there is more than one for any particular sub-net.

Deleting sewers

Clicking on the “Delete Sewer” button (Figure 4.4) will give you the option to delete
the selected sewer or not. Note that the attached junctions will not be deleted (as
you may want to use them). To delete junctions, see below.
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Displaying, repositioning and changing details of a junction

As with the sewer details, change to Edit mode by clicking the button shown in
Figure 4.10. This time choose “Junction” from the two options in the “Item to select”
box next to it.

Figure 4.14 Highlighted selected junction.

To reposition a junction, left click on the white panel, the nearest junction will be
highlighted with a red circle – see junction j6 in Figure 4.14. By moving the mouse
while still pressed, the position of the junction and the sewers connected to it can be
changed.

[Note again that this position, and sewer length change, is only a convenience for
viewing; it does not necessarily represent what the network looks like on the ground.
The simplified sewerage system does not take into account the orientation of
individual sewers – only their gradient. However, it is probably useful to draw the
network so that it is at least similar to the expected layout.]

To highlight the junction without moving it, right-click the mouse near a junction.
Details will be displayed on the right panel – see Figure 4.15.

Like sewers, junctions also have properties that are displayed when clicking on the
junction. There are only two properties:

1. Name, and
2. Ground level (in metres).

These properties may be changed on the Details panel to the right (Figure 4.15).
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Figure 4.15 Details panel for junctions.

Deleting junctions

Clicking on the “Delete Junction” button will give you the option to delete the selected
junction – but only if the junction is currently not connected to a sewer. If it is
attached to a sewer, you must first delete the connected sewer before deleting the
junction.

Changing what is displayed

To change how much detail is displayed on the screen there are seven “Display
option” buttons, as shown in Figure 4.16.

Figure 4.16 Display option buttons.

The first six toggle on and off to show sewers, junctions, sewer names, junction
names, drop junctions and datum junctions, respectively.

The seventh button scales the network so that it is all shown in the window.

Displaying of sub-nets

To the right of the tool bar are three controls for viewing sub-nets (Figure 4.17): a
drop down list selector to choose the sub-net to highlight, an option to show the sub-
net or not and a button labelled “Check Network”. Initially the selection list is empty,
and no sub-net can be shown. Before they can be shown the network must be
checked for consistency of the sub-nets. Pressing the Check Network button does
this. If the network passes the connectivity check, the selector list will automatically
be filled with the names of the existing sub-nets. Check the “Show” box and the
chosen sub-network will be displayed in green.

Figure 4.17 Sub-network display controls.
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4.3 DATA ENTRY/EDIT SCREEN

This screen (Figure 4.18) presents a series of tables and boxes to allow you enter
(or edit) data to describe the sewer network layout, and usage requirements.

Figure 4.18 The Data Entry/Edit Screen with example data.

Figure 4.18 shows the lists and boxes filled in for a typical example (details of this
example network can be found in Section 4.7.3.) This example is stored in the sewer
network file example03.snt. These files all have the extension “.snt”. An .snt file
contains the network description as well as the calculated details – sizes, slopes,
depths etc. – if they have been calculated. These files may be easily read, saved
and read back into the program. From this data entry screen the button labelled
“Read Network” (Figure 4.19) will open a dialog allowing you to choose one of these
files and load it into the program.

Figure 4.19 The Read Network button.

You have the choice to either use an old network file or create a new one. If you read
one in, you may freely edit and change its configuration to the new design. However,
it may sometimes be more convenient to start a new network.
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You may enter a network, or project, title in the Title Edit box (Figure 4.20). This title
will be saved in the .snt file and appear on graphs and other printouts of the solution.

Figure 4.20 The Title Edit box.

A sewer network is made up of named sewers that join at named junctions. Thus
each sewer has an upstream and a downstream junction. Sewers and junctions each
have their own properties (see below) which in total describe the sewer layout and
the wastewater flows for which the design will be made.

This screen provides an alternative to the Visual Edit screen for entering, displaying
and editing all of the network and demand properties.

The names of all the sewers are listed in the Sewer List box (Figure 4.21). Clicking
on any one of these displays the properties of that sewer in the edit boxes to the
right.

Figure 4.21 The Sewer List Box and Sewer Data Edit boxes.

Editing sewer properties

See Section 4.3 (under the heading Displaying and changing details of a sewer) for a
detailed description of the sewer properties that need to be entered.
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Many of the sewer properties may be altered in the edit boxes – the text colour will
change to red. It will change back to black when you click on another box – if it does
not change back to black, it has not been recorded!

If a junction name is entered that does not appear in the junction list on the right, that
name is automatically created and displayed as a new junction on the list.

A new sewer can be added to the network by pressing the right mouse button in the
sewer list box and selecting Add Sewer (Figure 4.22). The sewer is given a unique
name and default property values which must be edited to fit in the network.

Figure 4.22 The Add/Delete options for Sewer/Junction when right-clicking the list .

To remove a selected sewer from the network choose the Delete Sewer option. You
will be prompted to confirm this deletion to help prevent accidental removal.

Editing junction properties

Like sewers, junctions also have properties that are displayed when clicking on the
junction name in the junction list box (Figure 4.23). These properties are described in
detail in Section 4.3 (under the heading Displaying, repositioning and changing
details of a junction).

Again, as for sewers, the junction properties may be edited and the changes
recorded by pressing the Apply Change button below the Junction Data Edit box.

 

Figure 4.23 The Junction List and Junction Data Edit boxes.
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Once the sewers and junctions have been specified, the sewer network description
is complete. It is necessary to perform some checks to ensure that it is described
correctly and that it does not contain any loops. To perform these checks, press the
Check Network button shown in Figure 4.24.

Figure 4.24 The Check Network button.

A network may be valid and correct with junctions that are not connected anywhere.
It may be that these are placed with the expectation that new sewers will join them
later. On the other hand it may be better to remove them to keep the network tidy. To
remove all unconnected junctions choose the Options menu so that the item “Delete
Unused Junctions” (see Section 4.6 for all menu details) is checked before pressing
the Check Network button. (You could also remove the surplus junctions one by one
by clicking on their name in the junction list box and pressing the Delete Junction
button shown in Figure 4.22.)

Once the network has been entered and checked, it should be saved before going
any further. As mentioned above, sewer networks should be saved to .snt files. To
save a sewer network, choose File from the main menu bar, and select either Save
Network or Save Network As … (Figure 4.25); the latter option allows you to save it
under a new name.

Figure 4.25 The File Menu showing the “Save Network” options.

This saved file can be read in again during this session on the program or at any
time in the future when the network description will be again be displayed in the
tables exactly as it was saved.
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After entering and saving the network, go on to the Results Table screen by pressing
the Results Table button on the top tool-button bar. A solution will be automatically
calculated and displayed.

4.4 RESULTS TABLE SCREEN

This screen (Figure 4.26) presents the designed sewer network. All the required data
for constructing the sewer are shown in this table.

Figure 4.26 The Results Table screen.

If a sewer network has been previously entered – by reading from an existing file, via
either the Data Entry/Edit or Visual Editor screens – then the solution will be
automatically shown when this screen is displayed.

Note: You cannot edit the values in this table. To obtain a different solution you must
edit the initial data and/or the calculation parameters.

Each column of the table has a heading, shown more clearly in Figure 4.27, which
identifies the parameter found there for each sewer. The data for each sewer are
written on a single row, and the sewer is identified by its name in the first column
headed "Sewer".
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Figure 4.27 A sample of the Results Table.

The table will normally be wider and longer than your monitor screen; the columns
and rows that are not visible can be viewed by moving the bottom and right scroll
bars. Each column width may be changed (widened or narrowed) by placing the
mouse cursor over the line separating any heading; when the cursor changes to two
vertical lines, press the left mouse button – moving the mouse will then adjust the
column widths of the two adjacent columns.

As well as displaying the solution, this screen also allows the setting of parameters
for the whole network (the Data Entry/Edit screen allows setting of data for individual
sewers of the network). These “global” settings are made by changing the values in
the edit boxes above the table.

The default values which appear on this screen have been chosen to be those (or
very close to those) that should be used. Great care should be taken when using
parameter values that differ greatly from these default values.

The parameter setting will now be explained. The first column of four edit boxes
(Figure 4.28) deals with water consumption which, together with the population
setting from the Data Entry/Edit screen of each sewer (Figure 4.21) define the water
use. If “Population” was chosen to define use, then only the top two boxes – initial
and final consumption – need be set. However, if “Houses” was chosen, then the
lower two boxes – the initial and final mean number of people per house – are also
required to define the total number of people using the sewer and hence the total
water use.

Figure 4.28 Water consumption data edit boxes.

The rest of the settings deal with how the sewer design calculations are to be
performed.
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Figure 4.29 Calculation parameters.

Figure 4.29 shows the options to set either the minimum self-cleaning velocity or
minimum tractive tension, or both. (Only one solution will be displayed based on one
of these methods; however both calculations are performed, so both values should
be entered.) The value for Gaukler-Manning’s n (shown as G-Manning’s n) may also
be set in the next edit box. The minimum cover of sewer is the depth set for the
upstream junction that has been designated as the datum junction. All other depths
will be calculated relative to this according to the calculated sewer gradients.

Figure 4.30 Calculation parameters.

Figure 4.30 shows the edit boxes for Return Factor (entered as a percentage) and
Peak Flow Factor. Also shown is the choice of calculation for which results will be
presented – Min Vel refers to the calculation based on minimum self-cleansing
velocity, while Min Tau refers to that based on minimum tractive tension.

It may be desirable to set some design limits for the calculation. Three check boxes
are provided for this (Figure 4.31). Ticking the Minimum Flow check box means that
if the sewer demand is less than the minimum entered in the edit box to the right,
then this minimum is used for the sewer design. Ticking the Minimum Diameter
check box means that no sewer of diameter less than the entered minimum will be
used. Ticking the Ground Slope Limiting box means that the minimum slope of the
sewer will not be less than the ground slope.

Figure 4.31 Limiting values and Velocity of Flow equations.

Also shown in Figure 4.31 is the choice of velocity of flow equation – Gaukler-
Manning (shown as G-Manning), Colebrook White (shown as CW) or Escritt.
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When changes have been made to any parameters, to see what effect these
changes have on the solution the Update Table button (located below the table –
Figure 4.32) must be pressed. The table will then be updated with the new results.

Figure 4.32 The buttons below results table.

The other three buttons shown in Figure 4.32 allow the saving and printing of the
solution. The first two buttons save to CSV files (CSV files contain data from the
Results table with each item of data being separated by a comma – thus CSV from
“comma separated variable”). This format of file can be easily read into most
spreadsheet programs (including Microsoft Excel), so enabling further processing or
presentation in reports. The Save Table to CSV button allows saving to a new or
existing file; and the Append Table to CSV button adds the data in the table to the
bottom of an existing file; this is useful if several scenarios are to be tested and
analysed later.

The Print Page Layout button opens a dialog to allow the setting of print options –
page margin, orientation etc. The Print Preview button allows a preview of the page;
you may also print directly from this preview screen.

Should it be necessary to examine the detail of a calculation for a particular sewer,
then choose that sewer (just click on a particular row of the table) and press the
Calculator button on the main Tool Button Bar (Figure 4.2). The calculation screen
will be displayed containing full details of the calculation performed and solutions
obtained for that sewer. This screen is described in detail in Section 4.5.

4.5 CALCULATOR SCREEN

This screen (Figure 4.33) presents the detail of the calculation for an individual
sewer. Opening the screen automatically displays the design parameters for the
current sewer of the Results Table (the last sewer row to be clicked on or highlighted
on the Visual Edit screen).

This screen allows the calculation to be performed with new demand data or new
calculation parameters, so that changes in design can be investigated. Any changes
made to this screen are not transferred to the Results Table of sewer data.

To the left hand side of the screen are displayed all the design parameters; these
have been taken from those previously entered on the either the Data Entry/Edit or
Results Table screens.

The first eight of the edit boxes for the design parameters deal with the sewer's initial
and final demand in terms of population and water consumption (Figure 4.34); see
Section 4.2 for a description of these.
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Figure 4.33 Sewer Calculation screen.

Figure 4.34 Water consumption settings.

Below these the design parameters (Figure 4.35) and design limits (Figure 4.36) are
displayed.
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Figure 4.35 Design parameters.

Figure 4.36 Design limits.

Note that you may change the ground slope here; this is not possible on the Results
Table form as that would entail changing junction/network data. It is possible here as
this screen is only concerned with a single sewer.

The Calculator screen shows results of calculations based on both minimum self-
cleaning velocity and minimum tractive tension. The results are displayed side-by-
side, as shown in Figure 4.37.

Figure 4.37 The two solutions side by side.

The calculated gradient and diameter of the sewer for both calculations are shown in
Figure 4.37 (the diameter may be the set minimum if that option was chosen). If the
gradient is limited by the ground slope, then this limit will be shown as the minimum
gradient.
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The total initial and final flows are calculated and displayed at the top of the screen.
If either the Colebrook-White or Escritt equations have been chosen, then the
equivalent Gauckler-Manning’s n is displayed next to these (Figure 4.38).

In Figure 4.39 the chosen sewer (from the list of available sewers) is displayed and,
to enable a check on the solution, so are the d/D and velocity values for the initial
and final flows. (Remember d/D should always be greater than 0.2 and the minimum
velocity should be greater than that set – if this was the chosen design method.)

Figure 4.38 Check sewer design.

Figure 4.39 Chosen sewer selector.

4.6 MAIN MENU OPTIONS

The Menu bar at the top of the screen allows an alternative way to perform several of
the operations available on the four main screens, as well as offering some
additional functionality.

4.6.1 File Menu

The File menu (Figure 4.40) allows you to save and read the network description
using the Save Network and Read Network options.

The Clear Network option deletes all entered data and starts a new network – so be
careful with this option!

The Save Solution Table as CSV option allows saving of the results table to a CSV
file – see the description of the Results Table screen (Section 4.4) for a full
explanation of this.

The Save Image of Screen to Clipboard option makes a copy of the program screen
in the Windows clipboard – you may then copy this into your word processor by
choosing the paste function (or pressing keys Ctrl-V) from within that program. This
may be useful for including design details in reports.
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Figure 4.40 File Menu.

The next four options deal with printing the results. Print Setup allows you to choose
which printer and paper to use. Print Image of Screen will print the displayed
program screen on the chosen (or default) printer.

4.6.2 View Menu

The View menu has five options (Figure 4.41). The first four reproduce the
functionality of the first four buttons of the main toolbar (Figure 4.2), i.e. they enable
switching between the four main forms of the program.

Figure 4.41 The View menu.

The fifth option opens a window that allows control of the appearance of the Result
Table. This window is shown in Figure 4.42.

The window contains a list of the headings for each column of the Results Table. If
the adjacent check box is ticked, then that column will be displayed in the Results
Table. By default all columns are shown. To view any change in the Results Table
press the Apply button.
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Figure 4.42 Table View Control window.

4.6.3 Options Menu

The Options menu gives two choices.  The first item “Delete unused junctions” can
be ticked on or off (Figure 4.43 shows it on). When on, any unused junctions (i.e.
those not associated with a sewer) will be deleted when a check on the network is
performed.

Figure 4.43 The Options menu.

It is sometimes useful not to have these deleted – for example, when you wish to use
the junction at a later time, but wish to check its current connectivity.

The “Remove highlights” option refers to any sewer or junction that has been
displayed (highlighted) in red on the Visual Editor screen. Choosing this item will
clear this highlighting.
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4.6.4 Tools Menu

The Tools menu displays two items that give access to small “helper” screens that
appear when the item is chosen.

Figure 4.44 The Tools Menu.

The “Section properties” item displays the screen shown in Figure 4.45. This screen
allows quick calculation of the hydraulic properties of circular channels.

Figure 4.45 The Section Properties Helper screen.

The second item “Max. no. of houses” shows a screen (Figure 4.46) that allows a
quick calculation of the number of houses that can be safely connected to a
minimum sized sewer at minimum gradient, based on the minimum flow (single WC
flush) (see Section 3.3.6).
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Figure 4.46 The Minimum Gradient Helper screen.

4.6.5 Help Menu

The Help Menu has three items, which are typical choices for Windows-based
programs. “Contents” brings up the help pages which should help answer most
queries about how to use the program

If a query is not answered, it may be worthwhile choosing the second option “Web
page” which will attempt to open the PC’s standard web browser in order to connect
to the web support page for the program.

Figure 4.47 The Help Menu.

The “About” item displays useful program and author details.

4.7 QUICK START EXAMPLES

These four worked examples demonstrate all the steps necessary to build simple
sewer networks. These examples also demonstrate the use of some of the
calculation options. Data for all four examples can be found in the Networks directory
where the program was installed.
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4.7.1 Example 1 – A single line of sewers

This example is a simple series of four connected sewers joined as shown in Figure
4.48.

Figure 4.48 Example 1 sewer layout.

The first thing to do before entering the sewer network data on the Data Entry/Edit
screen is to draw your system of sewers on paper and label each junction and sewer
in a similar way to that shown in Figure 4.48; this will make the job of data entry
much easier.

As a minimum to get your basic layout entered you will also need the following for
each sewer: its length, and the number of people using the sewer (this may be
described in terms of the number of houses connected together with a mean number
of people per house, or in terms of a single total number of people who live in
houses connected to the sewer). This example will specify the number of houses
connected. For each junction (or node) of the network the ground level is required.

The data for this example are as follows:

Sewer name Length (m) Number of houses
connected

Sewer01 10 1
Sewer02 8 1
Sewer03 7 2
Sewer04 9 1

Junction name Ground level (m)
j1 100.0
j2 99.0
j3 98.0
j4 97.0
j5 97.0



68

To enter the data display the Data Entry/Edit screen. First enter a title for the network
in the edit box next to the label "Title". This will appear on saved results and
printouts. To input the sewer data first create the sewers by pressing right mouse
button and choosing the “Add Sewer” option (see Figure 4.22). Do this four times.
This will create four new sewers with the names S0, S1, S2 and S3, all with the
same default data. These can now be edited to represent the above network.

Click on S0 in the list of sewers and change the sewer name to sewer01, the length
to 10.00, the upstream junction to j1 and the downstream junction to j2. Click on the
“Houses” option so that a black dot appears next to the label “Houses” and enter 1 in
both the initial and final number of houses edit boxes. The data in the edit boxes
should now look like those in Figure 4.49.

All names and labels in this program are case sensitive. For example, a sewer
named sewer01 is not the same as a sewer named Sewer01.

Note: as you type in any of the boxes on this screen the text will change to red
indicating that the data have been changed. Clicking on the next box will change the
text colour to black. Only when the text has changed colour back to black will the
change be recorded.

Figure 4.49 Data for sewer01.

In a similar way enter the data for sewer02, sewer03 and sewer04, so that the data
are as shown in Figures 4.50, 4.51 and 4.52, respectively.



69

 

Figure 4.50 sewer02 data. Figure 4.51 sewer03 data.

Figure 4.52 sewer04 data.

Now enter the junction data. There should be a list of seven junctions in the junction
list – the five you have entered plus “J_up” and “J_down” which are default names;
these may be left in or deleted. Leave them in for now.

Click on ”j1” to display the junction data. Leave the name but enter the ground level
as 100.00 m. The data should then appear as shown in Figure 4.53.
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Figure 4.53 Junction j1 data.

In the same way change the data for junctions j2, j3, j4 and j5 to appear as shown in
Figures 4.54, 4.55, 4.56 and 4.57, respectively.

 

Figure 4.54 Junction j2 data. Figure 4.55 Junction j3 data.

 

Figure 4.56 Junction j4 data. Figure 4.57 Junction j5 data.

The datum junction must now be set. We will use the upstream end of the network
for this, i.e. the upstream junction of sewer01, j1. Click on sewer01 in the sewer list,
so that the screen looks something like Figure 4.49. Click on the “Set this junction as
datum” button and the screen shown in Figure 4.58 will appear. Check the “Set this
junction as the datum” box and then press the Apply button.
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Figure 4.58 Junction j5 data.

When the data are entered, the Screen Data Edit screen should appear as shown in
Figure 4.59.

Figure 4.59 Data for Example 1.

Next check that the network is connected correctly. On the Options menu make sure
the “Delete unused junctions” item is ticked (this removes the unnecessary "J_up"
and "J_down" junctions during the network check), then press the Check Network
button. If all is well, a message will be displayed telling you that the network has
passed its check. If it does not pass, go back through all of Figures 4.49-4.59 until
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your screens look the same for each junction and sewer, and then check the network
again.

Now save this network: on the File menu choose the first option Save Network. A
standard Save Dialog will open allowing you to either choose an existing name or
enter your own file name. For this example enter your own file name with the file
extension “.snt” – for example, myexample1.snt.  This will allow the file to be found
more easily when you need to read back the data.

The entered network may now be viewed on the Visual Editor screen. Click the
Visual Editor button. The network will look something like that shown in Figure 4.60,
and it obviously does not represent what you have entered – the problem is that you
have not entered position data for the junctions. The junctions have been given
default locations and sewers drawn at default lengths, which means they are all
drawn on top of each other! The junctions now need to be repositioned.

Figure 4.60 View of the Quick Start Example 1 network before repositioning.

Click on the Edit Mode button and select the Junction option, as shown in Figure
4.61.

Figure 4.61 Edit Mode button and selector.

Left click the mouse on a junction and, with the mouse button pressed, drag the
junction to a new position. Repeat this on each junction until all have been positioned
to give a view that represents the network – similar to that shown in Figure 4.62.

Figure 4.62 View of the Quick Start Example 1 network after repositioning.
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You can now view the results. To proceed to the Results Table press the button in
the top toolbar. The solution for this sewer will be displayed as shown in Figure 4.63.

Figure 4.63 Results Table for Quick Start Example 1.

On your screen you will probably see many more columns of data. The full number
of columns displayed can be reduced to avoid confusion or to display only the data
you are interested in. Choose the View Menu and the “Select Columns to View” item.
This will display the window shown in Figure 4.64, which is used to switch on or off
the display of each column. With the list of column titles displayed, place a tick in the
boxes next to the parameters you wish to display, and then press the Apply button.

Figure 4.64 The Table View Control window.
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The network data file for this example is supplied with the program under the
filename example01.snt.

4.7.2 Example 2 – Adding a branch sewer

Figure 4.65  Example 2 sewer layout.

This example builds on the network described in Example 1 by attaching a sewer
branch that joins at junction j3, as shown in Figure 4.65.

The first step is to read in the Example 1 data. If you completed Example 1 you may
read your file; however to be sure to get the correct data, it is preferable to read the
file example01.snt supplied with the program.

To read the data file choose the File menu and the “Read network” item. Choose the
file “Example01.snt” in the Networks directory and read it in – the screen should now
look similar to that shown in Figure 4.62.

On the Visual Edit screen click the Draw Mode button (the yellow pencil). Draw two
lines on the screen in approximately the same place as sewer05 and sewer06 in
Figure 4.65.

You should now have two new disconnected sewers, S0 and S1, and four new
junctions J0-J3, as shown in Figure 4.66.
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Figure 4.66  The added sewers and junctions.

These new sewers need to be connected and renamed. In the Edit Mode choose the
sewer option (Figure 4.61). Click on sewer S0; it will turn red and its details will be
displayed on the right panel.

Change the sewer name to sewer05, its length to 20.0m and its downstream (D/S)
junction to j3 (choosing this from the list). Also choose the Houses option and set
initial and final number both to 1. The display should now look something like Figure
4.67.

Figure 4.67  The sewer05 selected and connected to j3

Now select sewer S1 by clicking on it and change its name to sewer06, its length to
10m and select J1 for the D/S junction. Again choose the Houses option and set the
initial and final number both to 1. Then choose “Junction” from the Item to select
option (Figure 4.61) and click on junctions J1 and J2, one by one, dragging and
repositioning them to give a better layout as necessary. The display should then look
something like Figure 4.68.
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Figure 4.68 Sewers sewer05 and sewer06 connected and repositioned.

The last thing to do is to delete the unused junctions J0 and J3 and rename J1 and
J2 setting their levels. To delete junction J0, make sure you are in Edit mode and
have Junction chosen; now right click on the junction and it will be highlighted with a
red circle and its details displayed on the right hand panel. On this panel click the
“Delete Junction” button. Repeat this for junction J3.

To rename junction J1, stay in Edit mode, right click the junction until it is highlighted;
now type the name “j6” in the name box and set the level to 98.0m. Click the “Apply
Changes” button. Do the same for junction J2 changing its name to “j7” and its level
to 99.0m.

You can now proceed to the Results Table by pressing the button in the top toolbar.
The solution for this sewer will now be displayed.

The network data file for this example is supplied with the program under the
filename example02.snt.

4.7.3 Example 3 - Branch conversion to two sub-networks

Example 2 has two branches that join at junction j3 and the whole network was
calculated with all parts linked together. An alternative method of designing this type
of sewer allows each branch to be designed as a separate network of defined sub-
nets, as discussed in Section 4.1.3. This is useful when one of the sewers is to be
designed to receive stormwater (see Section 3.3.3).  We will use the data of
Example 2 to demonstrate the use of sub-nets.

The network file supplied with the program for Example 2 is example02.snt. The first
step is to read this in as a new network. We will convert this to have two sub-nets
with one running from junction j1 to j5 and the other from j7 to j3. From this
description there appears to be no difference between this layout and that in
Example 2. This is so, but what we have done allows the second leg to be designed
so that it may join at junction j3 at a different (higher) level if necessary. This may be
desirable if the main leg is a previously designed sewer or one where levels are
constrained for some reason.
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This alteration – allowing a sewer to join a junction at a different level – creates a
“drop junction” at the downstream end of the sewer. Here, it is sewer05 that will have
the drop junction at junction j3 on sewer02, so select sewer05 (change to Edit Mode,
choose Sewer from the selection, then click on sewer05) so that it is highlighted in
red (see Figure 4.69).

Figure 4.69 Highlighted sewer05 marked with a drop junction.

On the details panel to the right check “D/S Drop junction”; a red spot will appear on
sewer05 near junction j3, indicating the drop junction. This branch is now a sub-net
of two sewers, sewer05 and sewer06. As it is a sub-net it requires a datum, so select
sewer06 and select its upstream junction, j7, as the datum by clicking on the “Set
this junction as datum” button and completing the window so that it appears as
shown in Figure 4.70.

Figure 4.70 Marking the datum for the sub-net.

Remove the highlights from the network by choosing the Options menu and then the
Remove Highlights option. The network should now look something like Figure 4.71.
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Figure 4.71 Network for Example 3.

Each sub-net can be displayed. (It is very easy to see which is which in this example,
but in more complex networks this may not be the case.) First the network must be
checked by clicking the Check Network button on the top tool-bar of the Visual Editor
screen (Figure 4.72.)

Figure 4.72 Sub-net display controls.

If the network passes the check, then a message will appear to confirm this; if not,
correct the network and check again. (Failures of the network check usually occur
because a datum has not been set for one or more sub-nets, or the network loops in
some area.)  There will now be a list of sub-nets in the dropdown box of Figure 4.72,
with the first, Subnet 0, displayed. To show the sub-net on the screen tick the Show
box (Figure 4.73) and the display should look like that in Figure 4.74, with the
selected sub-net shown in green.

Figure 4.73 Selecting Subnet 0  to be displayed.
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Figure 4.74 Subnet 0 displayed in green.

To highlight the second sub-net, simply select Subnet 1 from the dropdown list in
Figure 4.73. This sub-net is now shown highlighted, as in Figure 4.75.

Figure 4.75 Subnet 1 displayed in green.

4.7.4 Example 4 – The UNCHS design example

This example is the UNCHS design example discussed in Appendix 2. The data for
this network are supplied with the program in the file unchs.snt. Read this in and you
should see the Data Entry/Edit form as shown in Figure 4.76. On the Visual Edit
screen the display should be something like Figure 4.77.  You can now proceed as
described above in Examples 1-3.
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Figure 4.76 UNCHS example data.

Figure 4.77 UNCHS example data as shown on Visual Edit screen.


